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1. Disclaimer / End User Agreement

For the consideration of using this website, including any apps arising out of said website, you, hereby referred to as 
the user, explicitly agree to the following terms and conditions:

1. Intellectual Property Rights- 

a. Unless otherwise stated, the HydroSketch Development Team or our licensors own the intellectual 
property rights in the website app and material on the website and all the HydroSketch 
Development Team’s intellectual property rights are reserved. Additionally, it is expressly prohibited 
that the user not reproduce, duplicate, copy, sell, resell, visit, or otherwise exploit the HydroSketch 
Development Team website app or material on the website for a commercial purpose and/or use 
said content for an improper purpose, without the HydroSketch Development Team’s express 
written consent. 
 

b. User agrees that when users submits content through the HydroSketch Development Team’s 
website app the owner and/or proprietor of such content belongs to the HydroSketch Development 
Team and they are free to license, publish, display, modify, patent, trademark, copyright, declare as 
a trade secret, distribute, destroy, alter and/or syndicate user’s content worldwide. The Submitter of 
data that generate any diagrams or files are the possession of the Submitter and can publish, 
distribute, destroy, or alter its contents.  

2. Waiver of liability –  

a. By using this website app the user agrees to forever release from any and all liabilities, in law or 
equity, and discharges, releases and holds harmless the HydroSketch Development Team and its 
agents, employees, current, former, or retired officers, employees, and successors, and assigns (in 
their individual, personal, official, representative and/or any other capacities) and/or any other 
authorized personnel from the beginning of the world to the most recent date of use of the website 
app.   
 

b. By using this website app the user specifically acknowledges that no special duty or responsibility 
has been formed and that any reliance on the user’s behalf will be deemed unreasonable.   

c. By using this website app the user specifically acknowledges this website app and its use does not 
constitute the filing of a notice of claim nor shall it be grounds to support a petition for permission to 
file a late notice of claim.   

d. By using this website app the user specifically acknowledges that this website app shall not 
constitute prior notice, written or otherwise, of any defects for which a cause of action could arise.  

e. By using this website and its app user acknowledges that the HydroSketch Development Team also 
may provide links to websites of other organizations to provide visitors with certain information. If 
user clicks on the links on these pages, user will be leaving the HydroSketch Development Team’s 
website. The HydroSketch Development Team’s provision of these links does not imply approval of 
the listed destinations, warrant the accuracy of any information in those destinations, constitute 
endorsement of the entities to whose sites the links are made, or endorse any of the opinions 
expressed on any of these outside websites.  These websites operate under the auspices and at 
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the direction of their respective owners. If user has a question or comment about any of these sites, 
user agrees to contact them directly on their site. 

f. By using this website and its app user acknowledges that the HydroSketch Development Team 
makes no representations, guarantees, or warrants concerning the accuracy and/or correctness of 
the information and/or representations made on the website and user agrees that no liability may 
arise and to hold harmless the HydroSketch Development Team and its agents, employees, 
current, or former employees, and successors, and assigns (in their individual, personal, official, 
representative and any other capacities) and/or any other authorized personnel from any liabilities, 
in law or equity, arising therefrom. 

3. Use of Website and its App  

a. User agrees not to use the HydroSketch Development Team’s website app in any way that causes, 
or may cause, damage to the website app or impairment of the availability or accessibility of the 
website. 

b. User agrees not to use the HydroSketch Development Team’s website app in any way which is 
unlawful, illegal, fraudulent or harmful, or in connection with any unlawful, illegal, fraudulent or 
harmful purpose or activity, and expressly acknowledges that any such activity could subject user 
to criminal and/or civil liabilities. 

c. User agrees not to use the HydroSketch Development Team’s website app for any purposes 
related to marketing without the HydroSketch Development Team’s express written consent. 

d. User agrees not to use the HydroSketch Development Team’s website app to copy, publish or send 
mass mailings or spam. 

e. User agrees the HydroSketch Development Team’s website app is not a public forum and thus not 
entitled to any Constitutional protections and/or guarantees. 

f. User agrees not to use the HydroSketch Development Team’s website app to copy, publish or send 
material which is illegal or unlawful, or material which could give rise to legal action under any 
applicable law. All material user copies, publishes or sends via the HydroSketch Development 
Team’s website app must not be defamatory, obscene, indecent, hateful, discriminatory or 
inflammatory; such material must not infringe any person's or entity’s intellectual property rights or 
rights of confidence, impinge upon any person's or entity’s privacy, or constitute incitement to 
commit a crime; further, material must not be misleading, deceptive, pornographic, threatening, 
abusive, harassing or menacing. 

g. User agrees that the HydroSketch Development Team reserves the right to edit or remove any 
material uploaded to its website and app. 

h. User agrees that the HydroSketch Development Team may take such action as the HydroSketch 
Development Team deems appropriate to deal with the upload of unsuitable material, including 
suspending or canceling the user’s account, restricting users access to the HydroSketch 
Development Team’s website app, or commencing legal proceedings against the user.  Additionally, 
user agrees that no liability, in law or equity, shall arise against and to hold harmless the 
HydroSketch Development Team and its agents, employees, current, former, or retired officers, 
employees, elected officials, successors, servants and assigns (in their individual, personal, official, 
representative and/or any other capacities) and/or any other authorized personnel for terminating 
user’s account and/or restricting and/or terminating users access to said website app. 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4. Miscellaneous Provisions- 

a. User agrees the HydroSketch Development Team may revise this disclaimer from time-to-time. 
User agrees to check this page regularly to ensure the user is familiar with the current version.   

b. This Disclaimer/End User Agreement constitutes the entire agreement by and between the user 
and the HydroSketch Development Team in relation to user’s use of the website app, and 
supersedes all previous agreements with respect to user’s prior use of this website app. 

c. This Disclaimer/End User Agreement will be governed by and construed in accordance with New 
York and/or any applicable federal and/or local law, and any disputes relating to this Disclaimer/End 
User Agreement shall be subject to the exclusive jurisdiction and venue of New York State 
Supreme Court in the Oneida County and/or if jurisdiction lies, then in the United States District 
Court for the Northern District of New York.  

d. User agrees, represents and warrants that by using the HydroSketch Development Team’s website 
app and/or clicking any boxes accepting the terms herein, that the user has read and fully 
understands the terms of this Disclaimer/End User Agreement, or if user has not read the 
Disclaimer/End User Agreement they accept any adverse actions they might suffer as a result of 
the user’s failure to do so, that the user is of good sound mind and capacity and capable of entering 
into the Disclaimer/End User Agreement. 

e. Although the restrictions contained in this Disclaimer/End User Agreement are considered by the 
parties to be reasonable, if any such restriction is found by a court of competent jurisdiction to be 
unenforceable, such provision will be modified, rewritten or interpreted to include as much of its 
nature and scope as will render it enforceable. If the provision at issue cannot be so modified, 
rewritten or interpreted to be enforceable in any respect, it will not be given effect, and the 
remainder of the Disclaimer/End User Agreement will be enforced as if such provision was not 
included.

f. All prospective HydroSketch users are given the opportunity to try HydroSketch for 30 days at no 
cost.  We encourage all prospective customers to take advantage of this trial to see if HydroSketch 
meets their needs.  Once a license is purchased there are no refunds available.
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2. Introduction
Thank you for accessing HydroSketch at (www.hydrosketch.com). This software is the first 
browser-based tool developed specifically to help HVAC (Heating, Ventilating, and Air 
Conditioning) professionals create piping and electrical schematics for hydronic heating and 
cooling systems.

Because it is browser-based, HydroSketch can operate on any desktop or laptop computer that 
can run the Google Chrome browser software (available for free download at https://
www.google.com/chrome/browser/ ).

There are several advantages of using browser-based software.  One is that users will always 
be working with the latest version of the software.  As the HydroSketch development team 
makes improvements, adds features, or creates additional component symbols and drawing 
templates, all users will have immediate access to those improvements, features, and templates 
without cost and without having to download and install new software. 

Another advantage is that your drawings are saved on a secure server.  As such you can 
access them whenever and wherever you have a computer connected to the internet.  The files 
are fully backed up and thus protected against loss due to property damage, theft, or hard drive 
failures.  

Finally, HydroSketch can be run from computers running any operating system (e.g., 
Windows®, Mac OS, etc.) that supports Google’s Chrome browser. 

HydroSketch vs. CAD software: 

Traditional computed aided drawing (a.k.a., CAD) software was developed to let users create a 
wide variety of drawings.  As such it usually offers hundreds of drawing tools and features, many 
of which may not be used depending on the needs of the user.  These tools and features also 
complicate the learning process and increase the cost of using CAD software.  Some CAD 
software licenses cost thousands of dollars per user. Some CAD software also requires “high 
end” computers and peripherals to run at optimal speed.  The costs associated with weeks of 
training and marginal productivity during the learning process is perhaps the most expensive 
aspect of dealing with traditional CAD software.

HydroSketch is not a traditional CAD software!

It was developed specifically to allow those who have no previous computer drawing experience 
to create simple and accurate schematics associated with hydronic heating and cooling 
systems.

HydroSketch features a simple and intuitive interface as seen in figure 2-1.  
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Figure 2-1:

The user selects the piping or electrical components they want to use in the drawing from 
several “toolboxes” located on the left side of the screen .  Each toolbox contains multiple 
component symbols associated with the name of that toolbox.  For example, the heat sources 
toolbox contains symbols for several types of boilers, as well as for heat pumps and solar 
thermal collectors.

The individual components within each toolbox are displayed in a scrollable palette whenever 
the user selects that toolbox by clicking on it.  The scrollable palette of heat sources is seen in 
figure 2-2.  The scroll bar at the right of the symbol palette lets the user move up or down within 
the palette.
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Figure 2-2:

Once a toolbox has been selected the user can drag any of the displayed symbols onto the 
white canvas area at the right of the screen.  This action creates a copy of the symbol on the 
canvas.

The initial placement of the symbols on the canvas is not important.  Symbols can be easily 
moved by placing the mouse cursor over the symbol, holding down the left mouse button, and 
dragging the symbol to another location on the canvas.

Each piping or electrical device symbol has one or more “ports,” which are points on the symbol 
where piping or wiring would connect.  The ports appear whenever the mouse cursor is close to 
or over the component symbol, and disappear when the mouse moves away from the symbol. 
Ports do not show when the drawing is printed.

After two or more symbols have been placed on the canvas they can be connected using 
“connectors.”  A connector is not just a simple line.  It’s a dynamically generated assembly of 
line segments that spans from a port on one symbol to a port on another symbol.  Connectors 
automatically adjust to the horizontal and vertical distances between these ports. They also 
automatically adjust as the component symbols they are connected to are moved on the 
canvas.
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After a connector is placed, any segment of the connector that’s not directly attached to a 
component symbol can be dragged to the preferred location.  All other segments on the 
connector automatically adjust to this movement.  

The width and color of any connector can be easily changed.  It’s also easy to add rounded 
corners (called fillets) to the corners of any connector.  These rounded corners make piping 
schematics look more realistic.

Section 4 will get you started using connectors.  You’ll quickly see how simple, efficient, and 
versatile they are.
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3. Accessing HydroSketch
The preferred Internet browser for use with HydroSketch is the latest version of 
Google’s Chrome.   

Please download the latest version of the Chrome browser from the following site, and 
install it on you computer before working with HydroSketch. 

https://www.google.com/chrome/ 

  
When you have the Chrome browser running, you can access HydroSketch by entering 
the following URL into the Chrome browser. 

http://hydrosketch.com/security/login 

This will take you to a page that looks like figure 3-1. 

Figure 3-1: 

If you are using the 30 day trial of HydroSketch you need to enter an e-mail address 
and create a password, and enter it at this screen.  Then click “Register”. 

If you already have a user name and password, enter it on this screen, then click the 
“LOG IN” button. 

You will then see the “user dashboard” screen shown in figure 3-2. 

Figure 3-2: 
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If you are using the 30-day trial period for HydroSketch, or have already purchased a 
HydroSketch license, and want to draw in HydroSketch, click on the “Use HydroSketch” 
button in the user dashboard screen. 

If you want to purchase a license for HydroSketch click on the “Purchase HydroSketch 
License” button and follow the instructions. 

If you own a HydroSketch license, and want to add or modify information for up to two 
additional users under that license, click the “Manage Users” button and follow the 
instructions. 

If you clicked on “Use HydroSketch you will see the screen shown in figure 3-3: 

Figure 3-3: 

Enter a name for your drawing, such as Jack’s schematic, then click on the “Submit” 
button. 

You will now see the main drawing canvas along with the Toolbox column at the left of 
the screen.  These are shown in figure 3-4. 

Figure 3-4: 
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The drawing name you entered will appear below the HydroSketch logo in the upper left 
portion of the screen. 

You’re now ready to do some drawing with HydroSketch. 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4. Getting familiar with HydroSketch 
The best way to start learning HydroSketch is to make a simple drawing using several 
of the available symbols and other tools. 

On the left side of the screen you will see the Toolbox.  It’s a column of symbol 
categories with names such as Heat sources, Circulators, Connector, and Text. 

Click on the “Heat Sources” symbol under Toolbox. The icon for the “Heat Sources” 
toolbox will have a red frame around it, indicating that it has been selected. 

You will also see a scrollable palette of several heat source symbols appear in a pop-up 
window that appears between the Toolbox icons column and the drawing canvas, as 
shown in figure 4-1. 

Figure 4-1: 
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Most toolbox palettes contain more symbols than can be displayed on a single screen. 
To see all the symbols in a given toolbox use your mouse to move the scroll bar at the 
right of the symbol palette. 

If you place you mouse cursor over one of the component symbols, and hold it there 
briefly, the name of that component will appear.  This is called “hovering” over the 
symbol.  It allows those who don’t know what the symbol represents to find its name. 

Using your mouse, drag the component symbol for the modulating/condensing boiler 
from the symbol palette onto the drawing canvas, so it looks similar to figure 4-2: 

Figure 4-2: 
 

When you drag a symbol from the symbol palette to the canvas a copy appears.  The 
original symbol never leaves the symbol palette. 

Once a symbol is on the canvas it can be moved around by dragging it with your 
mouse. Just place the mouse cursor over the symbol, hold down the left mouse button, 
and drag the symbol to another location on the canvas.  Release the left mouse button 
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at the desired location of the symbol.  You can drag any symbol as many times as you 
want. 

Let’s put a few more symbols on the canvas. 

Click on the “Specialty Components” under the Toolbox, and drag a symbol for a 
hydraulic separator onto the canvas as shown in figure 4-3. 

Figure 4-3: 

Don’t be too concerned about exactly where you put the symbol on the canvas.  It can 
always be dragged to a different location. 

Drag a few more symbols from the Circulator, Heat Emitter, and Valve toolboxes onto 
the canvas. 

Do this by clicking on the appropriate Toolbox at the far left of the screen.  You will see 
the symbol palette pop up between the Toolbox column and the drawing canvas.  Scroll 
up or down in the symbol palette to see what’s available, then drag a copy of the 
desired symbol to the canvas, as shown in figure 4-4. 
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Figure 4-4: 

Once you have a few symbols on the canvas, move the mouse cursor toward each of 
them.  As the cursor approaches each symbol you will see small gray circles called 
“ports” appear at the locations where lines representing piping can be attached to that 
symbol. 

Ports are the points from which, and to which you will drag a “connector.” 

Using connectors: 

Go to the connector tool under the Toolbox and click to select it. 

You will see another pop up window appear between the Toolbox column and the 
drawing canvas, as shown in figure 4-5. 
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Figure 4-5: 
 

You’re now ready to draw a connector between one of the ports on the boiler symbol, 
and a port on the hydraulic separator. 

With the Connector tool already selected under the Toolbox, position the mouse cursor 
over the lower right side port on the boiler symbol.  Hold down the left mouse button and 
drag toward the upper left port of the hydraulic separator.  As you do, you will see a fine 
dashed line following the cursor.  When you have the mouse cursor over the upper left 
port of the hydraulic separator release the mouse button.  You will then see the 
connector automatically generated between these two ports, as shown in figure 4-6. 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Figure 4-6: 

Connectors are “smart.”  Unlike simple line segments in a CAD system, connectors can 
automatically reshape themselves as you move one or more of the symbols they 
connect to. 

Try it.  Just drag the hydraulic separator symbol around the screen with your mouse and 
watch what happens.  The connector automatically adapts its shape and direction as 
you drag either symbol it connects to around the canvas. 

Editing connectors: 

If you take a close look at the connector you will see that a small curve called a “fillet” 
has been created where the vertical and horizontal segments of the connector come 
together.  You can think of this an an elbow in the piping.  It makes the piping schematic 
appear more realistic.   

You can easily change the radius of this fillet. Just click on the connector to select it.  
When selected you will see small blue circles at the ends of the connector.  Now, move 
the horizontal “slider” control under the word Radius in the pop up menu to the left of the 
canvas and watch what happens.  The default radius of fillets can be reduced down to a 
square intersection (set the slider to 1), or left anywhere in between.  You can also 
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change the radius of fillets by simultaneously holding down the “Control” (Ctrl) and “R” 
keys on you keyboard, and then rotating the scroll wheel on your mouse. 

While you have that connector selected try out the other editing functions in the pop up 
menu. 

For example, click on the color box at the top and then select a different color for the 
line.  You will see a color selector pop-up window appear elsewhere on your screen.  
This color selector window is created by the browser you are using, so it may change 
depending on the browser and version you are using.  You can change the color of the 
connector to any color that’s available in your browser’s color selection window. Just 
click on the color you want in the color selection window and the connector changes to 
that color. 

Try changing the width, the pattern, and the opacity of the connector.  Just use your 
mouse to drag the slider controls in the pop up window left or right and watch what 
happens to the connector. 

You can also add different types of arrowheads to one or both ends of the connector.  
The default is no arrowhead. 

Set the color of this first connector to red. 

Draw another connector from the lower left port of the boiler to the lower left side port of 
the hydraulic separator. 

You will see this connector created with the same color and width as set for the previous 
connector.  However, you can always change the color, width, pattern, and opacity of 
any connector at any time. 

Change the color of the second connector to blue as shown in figure 4-7.  Then try 
moving the hydraulic separator symbol around the canvas.  Notice that both connectors 
automatically adjust as the symbol is moved. 
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Figure 4-7: 

Next let’s put a circulator between the boiler and hydraulic separator. 

Using the right button on your mouse, right click on the green circulator symbol that was 
previously dragged onto the canvas.  You will see a pop up list of “edits” that you can 
make to that symbol. 

Click on “rotate 90º CCW.”  The circulator symbol will rotate counterclockwise by 90º so 
that it’s ready to go into a vertical line. 

Drag the circulator symbol over the blue connector as shown in figure 4-8. 
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Figure 4-8: 

The circulator symbol looks “OK” sitting on top of the blue connector, and from a purely 
graphics standpoint it is OK.  However, this circulator is not attached to the blue 
connector.  It’s just laying on top of it.  If the boiler or the hydraulic separator is moved, 
the circulator symbol will not stay on the connector, as shown in figure 4-9. 
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Figure 4-9: 

If you want the circulator to be attached to the connector you can delete the original 
blue connector and then create two new connectors; one from the boiler to the circulator 
outlet port, and the other from the circulator inlet port to the hydraulic separator.   

To delete a connector just right click on it and select “delete” at the bottom of the pop-up 
list.  You can also delete a connector by left clicking on it and then pressing the delete 
key on your keyboard. 

Alternatively, you could drag the end of the blue connector that’s attached to the boiler, 
and attach it to the lower port on the circulator.  Then, draw another connector from the 
lower port of the circulator to the lower left port of the hydraulic separator. 

After doing this you can drag the circulator symbol and the two new (attached) 
connectors will move with it. 

You may notice that one or both of new connectors appear as shown in figure 4-10. 
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Figure 4-10: 
 

Notice that the upper connector on the circulator is not leaving the circulator symbol in 
the correct direction.  This can be easily changed. 

Just right click directly on the small gray circle representing the port at the top of the 
circulator.  This opens a pop up selection box with choices such as “Direction 
top”,”Direction Right”, etc., as seen in figure 4-11.  Just click on the direction you want 
the connector to come out of the upper circulator port. In this case that would be 
“Direction Top.”  The upper connector adjusts to the correct direction as it leaves the 
circulator. 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Figure 4-11: 
 

Now that the connectors are leaving the circulator in the correct directions, drag the 
circulator symbol to the desired location. 

Let’s complete the simple schematic by connecting the manifold station and another 
circulator. 

Drag a manifold station from the symbol pallet for the Heat Emitters toolbox onto the 
canvas. 

Then, right click on it to open an edit menu and click on “flip horizontal.”  This does just 
what the name implies, it flips the symbol 180º around a vertical axis.  The ports on the 
symbol rotate with it. 

Next, move the blue circulator symbol down into the space between the hydraulic 
separator and the manifold station as shown in figure 4-12. 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Figure 4-12: 

Draw three new connectors; one from the upper right port of the hydraulic separator to 
the inlet port of the circulator, another from the outlet port of the circulator to the upper 
port of the manifold station, and the third from the lower port of the manifold station back 
to the lower right port of the hydraulic separator.  Your drawing should look similar, but 
perhaps not identical to figure 4-13. 

Figure 4-13: 
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If the connectors don’t leave the symbols in the correct direction right click on the pots 
where the direction needs to change, and select the desired direction for the connector 
leaving that port. 

You can now drag the circulator and manifold station to “clean up’ some of the 
unnecessary changes in direction of the connectors.   

You can then change the color of the upper two connectors to red by clicking on them 
one at a time and then clicking on the color bar at the top of the attribute window.  If the 
color shown in the color bar is not red, find the color selector window for your browser 
and click on red. 

Your drawing might look similar to figure 4-14: 

Figure 4-14: 
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Other things to try: 

Zooming: 

You can zoom in or out of the drawing by clicking on the + or - symbols at the lower right 
of the canvas.  Clicking “original” restores the view to its original size.  If the “-“ sign in 
this box changes to a faded red, you have reached the limits of zooming out.  You can 
zoom back in by clicking the “+” or clicking “Original.”  You can also zoom in or out by 
clicking on the “View” menu above the canvas, and then clicking on “zoom in,” “zoom 
out,” or “zoom original.” 

Scrolling: 

Use the vertical and horizontal scroll bars along the right side and lower side of the 
canvas to navigate around the canvas.  These are especially helpful when you are 
zoomed into one area of the drawing.  HydroSketch does not currently support scrolling 
using mouse wheels. 

Moving the schematic on the canvas: 

If you want to move the entire schematic, just draw a selection rectangle around it with 
the mouse cursor.  This selects everything inside the rectangle.  Place the mouse cursor 
over one of the selected objects and drag the cursor across the canvas.  The entire 
schematic moves as a single entity. 

Deleting: 

To delete an object from the canvas just right click on it, and choose “delete” in the pop 
up menu.  You can also delete an object by selecting it and pressing the delete key on 
your keyboard. 

Grouping & Ungrouping: 

Select two or more objects on the canvas by holding down the shift key and clicking on 
each object. You will see a small frame with square dots at its corners around each of 
the objects that have been selected.  If you don’t see this blue rectangle the object is 
not selected. 

Right click on one of the selected objects to see the pop up shown in figure 4-16. 
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Figure 4-16: 

Select “Group.”  This joins all the selected objects as if they were glued  together. 

You can also select “Group” under the Edit menu above the canvas. 

A previously created group can also be “ungrouped” back to the individual objects by 
right clicking on the group and selecting “ungroup” from the pop up menu, or by 
selecting “Ungroup” under the Edit menu. 

Nudging: 
  
When a symbol is selected it’s possible to move that symbol in one pixel increments 
using the up arrow, down arrow, right arrow, and left arrow keys on your keyboard.  This 
is especially helpful for making location adjustments on small components that have 
multiple ports (such as tees).  If the component has connectors attached to it they will 
automatically readjust possible as the symbol is nudged. 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5. Pull-down menus 
There are several pull down menus shown above the canvas area.  They will each be 
described in this section. 

File Menu: 

The File menu opens as shown in figure 5-1. 

Figure 5-1: 

New:   

Select “New” when you want to begin a new drawing.  If you have an existing drawing 
open you will see a prompt (shown in figure 5-2) asking if you want to save the current 
version of that drawing.  Clicking Save to save the current version of the drawing.  Click 
“Don’t Save” to move on without saving. Click “Cancel” to return to the currently open 
drawing.  

Figure 5-2: 
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After clicking either “Save” or “Don’t Save” you will be directed to another screen (see 
figure 5-3) where you create a new drawing and give it a name.  The new drawing name 
will appear in a listing along with previously created drawings. 

Figure 5-3: 
 

Once you’ve entered a drawing name, click the “Submit” button.  This opens the main 
drawing screen with a blank canvas.  The name you entered will appear as the file 
name just below the HydroSketch logo at the upper left of the screen. 

Import: 

The import command is for bringing a previously saved HydroSketch file into the 
program from a storage device connected to your computer. An example would be a file 
created  by another HydroSketch user, and sent to you as an e-mail attachment.   

Selecting import initiates the file selection process on your computer.  Use this file 
selection process to locate the file you want to import among the various storage 
devices connected to your computer.  Only files previous created by and exported by 
HydroSketch, and as such having the .hs extension can be imported. 

Open: 

This command allows you to open a HydroSketch file that the user had previously 
created.  Selecting “open” displays a listing of HydroSketch drawing files that have been 
previously created. Just click on the name of the file you want to open, and the 
previously created drawing will appear on the canvas. 
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Save: 

The save command saves the current status of the drawing to a secure server.  The file 
name has already been selected and appears in the upper left corner of the screen, just 
under the HydroSketch logo. 

Save as: 

The “Save as” command allows you to store the current status of the drawing using a 
file name that’s different from the original file name. When you select “save as” you will 
see a pop-up box asking for a new file name (see figure 5-4). 

Figure 5-4: 
 

  

Enter a new name for the drawing and then select OK to save it.  The file is then stored 
off-site on a secure server. 

Autosave Off: 

By default, HydroSketch automatically stores a drawing file with its given file name 
every 2 minutes as it is being worked on.  However, this feature can be turned off by the 
user.  If turned off it can be turned back on by selecting “Autosave On” under the file 
menu. 

Delete: 

This selection is for removing an entire drawing file (not to be confused with deleting 
an object on the canvas).   

Selecting “delete” opens a pop-up box asking if you really want to delete the current 
drawing file.  Clicking on “yes” will delete the file.  Once deleted the file can no longer be 
recovered.  Selecting “cancel” leaves the current file as is.  User’s can also delete files 
by clicking on the small trash can icon found at the right of each file name in the listing 
of current drawing files. 
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Print: 

Selecting print will display the print setup screen shown in figure 5-5: 

Figure 5-5: 

This screen is created by your browser.  It allows you to select the printer to which the 
drawing will be printed.  It also allows options such a the number of copies and the 
choice of color or black & white printing.   

Clicking on “more settings” displays additional choices such as paper size, margins, and 
scale.  The default paper size is “letter.”  

The print previous window appears at the right of these settings.  It shows 
approximately what the printed image will be, based on the currently-set zoom level and 
the shape of the currently-selected paper size. 

Select “Cancel” if you decide not to print the drawing when the print previous window is 
displayed. 
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Export:   

This selection creates a file for the current drawing on the user’s computer and displays 
an icon for that file ending with .hs ,which identifies it as a HydroSketch file.   

The icon for this exported file can then be attached to an e-mail, or saved on any 
storage device.  It provides an easy way to save a drawing file on the user’s computer 
(versus on a secure off-site server).  It also provides a simple way to exchange 
HydroSketch files with other users. 

——————————————————————————————————————  

Edit Menu: 
The Edit menu appears in one of two ways depending on what object(s) are selected on 
the canvas.  Both appearances are shown in figure 5-6.  Functions that are not “valid” 
for the currently selected objects on the canvas are not shown on the Edit menu. 

Figure 5-6: 

The functions listed in the Edit menu are used extensively in creating and making 
changes to drawings.  These functions can also be selected using keyboard short cuts, 
which can be found at the “quick reference” selection under the Help menu. 

Undo: 

This editing function will undo the last change made to the drawing.  This is very helpful 
when the user decides that the last change to the drawing is NOT wanted.  If selected 
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multiple times it will continue to undo the previous changes to the drawing in the reverse 
order in which they were made.  

Redo: 

Redo as the opposite of Undo.  If selected it will redo the change to the drawing that 
was just undone by the “Undo” selection. 

Group:   

This editing function is the equivalent of digital glue.  It allows you to select multiple 
objects on the canvas and bond them together as a single entity.  This is very helpful 
when an assembly of multiple objects, all positioned as desired, is used multiple times 
on the same drawing.   

It is also possible to have groups within groups.  An object that was formed by grouping 
other objects can then be grouped with a different object on the canvas. 

To use this editing function hold down the shift key and click on multiple objects on the 
canvas to select them.  This is called ‘shift clicking.’  Then select “group” under the Edit 
menu.  The selected objects are effectively bonded together and surrounded by a single 
rectangle frame.   

The group can be moved, duplicated, or rotated as if its a single object. 

Ungroup: 

This function does exactly as its name implies, it “ungroups” objects that have been 
previously grouped together.  Multiple ungroups are possible to ungroup nested groups 

Copy: 

This function copies the selected object(s) to the clipboard. Objects copied to the 
clipboard they can be pasted back to the canvas, which, in effect, creates a duplicate 
copy.  

Page �  of �33 49



REV92818

Paste:   

Selecting “paste” puts a copy of what was last copied to the clipboard onto the canvas. 

Duplicate: 

This function makes a duplicate of the selected object and places it on the canvas with 
a slight offset from the original. 

Delete: 

This selection deletes the currently selected object(s). 

Rotate: 

This selection rotates the selected object by 90º counterclockwise.  It can be used 
repeatedly.  Each time it is selected the object rotates another 90º counterclockwise. 

Flip horizontal: 

This selection flips the image 180º around an (imaginary) vertical axis.  It’s a convenient 
way to change the direction of components such as circulators.  When an object is 
flipped any connectors attached to it are deleted.  They can be redrawn. Grouped 
objects cannot be flipped horizontally. 

Flip vertical: 

This selection flips the image 180º around an (imaginary) horizontal axis.  It’s a 
convenient way to change the direction of components such as circulators.  When an 
object is flipped any connectors attached to it are deleted.  They can be redrawn. They 
can be redrawn. Grouped objects cannot be flipped vertically. 

Clear drawing: 

This selection is used when the user wants to clear ALL objects and text from the 
canvas.  When “Clear drawing” is selected the user is prompted with the pop-up shown 
in figure 5-7. 
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Figure 5-7: 
 

Clicking “OK” will remove all objects and text from the canvas.  Once the canvas has 
been cleared it cannot be restored using the Undo command. 

——————————————————————————————————————  

View Menu: 

The View menu opens as shown in figure 5-8. 

Figure 5-8: 
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Hide grid:   

This selection lets the user show or remove the light grid created on the canvas.  When 
on, the grid can visually assist with horizontal and vertical alignment of objects on the 
canvas. 

Zoom in:   

This selection zooms in on the canvas, and is useful when working on highly detailed 
areas of a drawing.   

Zooming in can also be done by clicking on the “+” sign seen in the red area at the 
bottom right of the canvas.  

Zoom out:   

This selection zooms out on the canvas, and is useful when working on large 
schematics.  Zooming out allows the user to see the extents of a schematic that, at 
normal viewing size, would not all fit on the canvas.  It reduces or eliminates the need to 
use the horizontal and vertical scroll bars found at the right side and bottom of the 
canvas.  Zooming out can also be done by clicking on the “-” sign seen in the red area 
at the bottom right of the canvas. 

When the limits of the zoom out capability are reached, the “-“ sign in the red area at the 
bottom right of the screen changes to a faded red.  Click on “original” to restore the 
default view size. 

Zoom original:  
  
This selection returns the view of the canvas area to its normal (default) size. 

——————————————————————————————————————  
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Help Menu: 

The Edit menu opens as shown in figure 5-10. 

Figure 5-10: 

Selecting “Quick reference” opens a separate window with a listing of many 
HydroSketch functions, and a listing of key combinations that can be used execute 
those functions.   

For example, to flip an object vertically, hold down the Ctrl and F keys simultaneously, 
and rotate the scroll wheel on you mouse upward (e.g. “mouse up”). 

To change the width of a connector, click on it to select it, then hold down the Ctrl and S 
keys simultaneously and scroll the mouse wheel up (to increase connector width), or 
down (to decrease connector width). 

Key combinations take some time to learn, but can speed the drawing and editing 
process once they are familiar. 

The“Quick reference” can remain open while you are working on a HydroSketch 
drawing.  This is especially helpful while learning to use key combinations 

The “Quick reference” window can be closed at any time by clicking the close window 
icon displayed at the top of the browser window.  It can also be minimized. 

Selecting “Download manual” under the Help menu will download a copy of this user 
manual to your computer as a PDF file.  That file will be placed at the location which you 
direct it to on your computer’s file access system.  To access that PDF file you will need 
to locate it on your computer and then use any PDF reader program such as Adobe 
Acrobat Reader, or Preview on the Mac OS X operating system. 
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6. Toolboxes 
This section discusses details on several of the toolboxes seen at the far left side of the 
HydroSketch screen. 

Text: 

To add text to a drawing, drag the text toolbox onto the canvas. You will see a small text 
box as seen in figure 6-1. 

Figure 6-1: 

Just begin typing the text you want. The text box will automatically expand as you 
continue entering text as shown in figure 6-2. 

Figure 6-2: 

When you’ve entered the text you want, just click elsewhere on the canvas.  

You may see a border around the text as shown in figure 6-3. 

Figure 6-3: 
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The width of the lines that form this border can be changed by using the controls in the 
attributes box at the left of the canvas.  Use the slider control to make the border wider, 
narrower, or move the slider to “0” to remove the border. 

You can change the default font (Arial) to other fonts by clicking on the “Font Family” 
attribute, and then clicking on one of the displayed font names. 

The size of the text can be adjusted up or down using the Font Size attribute.  Font 
sizes range from 8 to 100 points. 

The color of the selected text can be changed.  Select the text by double clicking on it, 
and then dragging across it.  Then, click the “Font Color” attribute.  This will bring up the 
color selector window for your browser.  Click on the color you want the text to be within 
this color selector window and the text will immediately change to that color.  Note: 
Once you’ve changed the color of the text, that color will remain active if you continue to 
add more text to the drawing.  You can always go back and change the color of any text 
using the Font color attribute. 

The default angle of the text is 0º.  This displays the text in the normal orientation.  You 
can change the angle of the text using the slider controller.  The angles to which the text 
can be set are increments of 90º. We recommend that the text angle be set to 0 prior to 
editing the text. 

The “Opacity” slider within the attributes window can be used to change the opacity of 
the selected text.  Lowering the opacity will make the text appear more transparent.   
Setting the opacity to 0 makes the text total transparent.  Setting the opacity to 1 makes 
the text totally opaque.  If text with reduced opacity is placed over other objects, it is 
possible to see some of the underlying object through the text. 

—————————————————————————————————————- 

Polyline: 

The polyline tool provides wide flexibility in how the user can add lines to the drawing. 

Note:  The polyline tool should not be confused with the connectors tool.   

The polyline tool allows you to create a simple straight line segment, or a more complex 
assembly of line segments, each having different lengths and angles. 

To draw a simple line segment click on the polyline icon in the toolbox column.  You will 
see a red frame around the polyline icon indicating that it is selected. 
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Next, move the mouse cursor to the location on the canvas where you want the line 
segment to begin.  DOUBLE CLICK the left mouse button at this location.  You will see 
the beginning of the line segment at the tip of the mouse cursor.  Drag the mouse cursor 
in any direction and a line segment will follow.  This action is called “rubber banding.” 

Move the mouse cursor to the location where you want the line segment to end and 
DOUBLE CLICK.  This terminates the line segment.   

The polyline tool will remain active until you click on the polyline icon under the toolbox 
to make it inactive, or click to use another tool.   This allows you to quickly draw multiple 
line segments without having to reselect the polyline tool for each segment.  

It’s also possible to draw polylines that have multiple line segments (hence the name 
“polyline.”)  Do this by starting the polyline with a DOUBLE CLICK, then move the 
mouse cursor to the location of the first vertex (e.g., the first change in direction point) 
and SINGLE left click. The second segment of the line will be created as you move the 
mouse away from this first vertex. You can continue to create multiple attached line 
segments by SINGLE left clicking at each desired vertex.  When you want to end the 
polyline just DOUBLE CLICK. 

The attributes window for polylines, shown in figure 6-4, allows you to change the width, 
color, and opacity of any polyline, much the same as with connectors.  

Figure 6-4: 
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Fillets (e.g., rounded corners) of various radii to be automatically generated at vertices 
between line segments.  Just use the slider bar in the polyline attributes window.  If a 
radius other than zero is set prior to drawing the polyline the radii will appear as it is 
drawn.  If radii are to be added to an existing polyline, select that polyline by clicking on 
it, and then use the radius slider to add the radii to all vertices in that polyline. 

The style of the line can also be changed using the Line Style selector in the polyline 
attributes window.  The default line style (solid) can be changed to multiple types of 
dashed lines as shown in figure 6-5. 

Figure 6-5: 

Orthogonal line on: 

If the check box next to “orthogonal line on” is checked in the polyline attributes window, 
as shown in Figure 6-6, the segments of the polyline will be restricted to horizontal and 
vertical directions.   

Figure 6-6: 

Each line segment will snap to either vertical or horizontal directions (whichever is 
closer) when there’s a SINGLE left click to create that segment. 

Editing polylines: 

Figure 6-6 shows a randomly created multi-segment polyline. 
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Figure 6-6: 

Left click anywhere on the polyline to select it.  You will see darker blue circles at the 
beginning and end of the polyline.  You will also see light blue circles at the center of 
each segment, and small white squares at each vertex, as shown in figure 6-7. 

Figure 6-7: 

You can ‘grab’ any of the white square handles and drag it to a different position.  The 
attached line segments will automatically follow this move, as shown in figure 6-8. 
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Figure 6-8: 

You can also move the starting or ending points of the polyline by dragging the market 
blue circles, as shown in figure 6-9. 

Figure 6-9: 
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If you click on any of the light blue circles that appear on each segment, that segment 
will be divided in half, and a new square handle will be placed at the mid-point.  You can 
then drag that new square handle to create a new vertex in the polyline, as shown in 
figure 6-10. 

Figure 6-10: 

Polylines are a very versatile tool.  We encourage you to “experiment” with creating 
polylines.  Try changing color, width, opacity, fillets at vertices, orthogonal constraints, 
and adding new segments. 

One use of polylines is creating “leaders” that point to some detail on the drawing and 
“lead” the viewer back to a word or line of text describing what is being pointed to.  You 
can make a leader line using only the polyline tool.  An example is shown in figure 6-11. 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Figure 6-11: 
 

Start at the text end, DOUBLE click to start the polyline, then SINGLE click where you 
want the vertex (change in direction).  SINGLE click where you want the point of the 
arrow.  SINGLE click where you want one side of the barb.  SINGLE click back on the 
tip of the arrow.  Finally, DOUBLE click at the other end of the barb. 

You can also make a leader by combining a polyline with one of the arrowheads found 
in the “Shapes” palette.  Draw the polyline.  Move one of the arrowheads from the 
“Shapes” tool palette over the end of the polyline.  Finally, group the polyline and 
arrowhead.  An example is shown in figure 6-12. 

Figure 6-12: 
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Shapes: 

Clicking on the “shapes” toolbox opens selection palette containing several “primitive” 
shapes such as circles, rectangles, and triangles.  Arrowheads pointing in several fixed 
directions are also shown in the shape palette.  

 Any of these shapes can be dragged onto the canvas and then modified.   

The size of the shape can be increased or decreased by clicking on the shape to select 
it, then using the mouse to drag inward or outward from any of the small selection 
handles (e.g, small white squares) that appear around the shape.  Figure 6-13 shows 
and example of these handles. 

Figure 6-13: 
 

When the shape is selected, and the cursor is placed over one of the small selection 
handles, a small arrow appears over the selection handle indicating a direction to drag 
that handle to increase the size of the object.  Although this small arrow points outward, 
indicating the drag direction for increasing the size of the shape, the handle can also be 
dragged inward to decrease the size. 

Shape symbols have a variety of potential uses. 

An individual shape symbol such as a rectangle with a specific color, size, border, etc. 
could be used to represent a component that’s not in one of the other toolboxes.  Note 
however that there are no ports on shapes.  Therefore they cannot latch to connectors 
like other pre-defined piping and electrical symbols.  Shape symbols can be placed “on 
top” of connectors or polylines, as can other component symbols.  Visually this is fine, 
however, any symbol placed “on top” of a connector or polyline will not move with that 
connector. 

Multiple shapes can be combined and “grouped” to create a unique new symbol. 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Custom graphics: 

This tool has multiple uses that allow additional symbols, imported images, and 
complete schematic templates to be added to HydroSketch drawings.

The upper section is labeled “Admin images.”  It allows the HydroSketch development 
team to add new symbols and template drawings to HydroSketch. Users can choose to 
import any image files listed in this area.  However, users cannot add or delete files 
listed under “Admin image files.”  

Users are encouraged to periodically check the “Admin images” list for new additions to 
HydroSketch.  These additions are immediately available to all HydroSketch users as 
soon as they are uploaded by the development team.

The middle section is labeled “User-defined images.” It lists graphic files that have 
been created or imported by the user. 

Creating a user-defined image:

To create a user-defined image from objects on the HydroSketch canvas follow these 
steps:

1. Arrange the objects as desired and then group them using the “group” selection 
under the Edit menu.

2. Right click anywhere inside the group, but not on the objects themselves.

3. Click the 'Save as' option.

4. Enter a name for the image file.

The image file name will then appear under “User-defined images” in the pop up 
window for the Custom graphics tool.

Importing an image:

HydroSketch can import images that are in either JPEG or PNG file formats.  

To import an image follow these steps:

1. Be sure the file you want to import is not too large.  We recommend that the 
maximum image size is 2 inches in either vertical or horizontal direction, and that its 
resolution not exceed 200 DPI (dots per inch).  Large image files, such as from digital 
cameras, can be reduced to smaller sizes using pixel editing software such as 
Photoshop, Pixelmator, or other similar software.
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2. Click on the Custom graphics tool to select it.  You will then see a pop-up window, a 
portion of which is shown in figure 6-12.

Figure 6-12:

3. At the bottom of this pop-up window, under “Import an image” you will see a button 
labeled “choose File.”  Click it to go to the file access system on your computer.

4. Navigate through your computer’s file system to the image file you want to import (it 
needs to be a JPEG or PNG file). Select it, and click the “open” button.  This adds the 
file name to the list under “Imported images”, along with a small trash can icon to the 
right of the file name.

Placing an imported image on the canvas:

To place an image from either “User-defined images” or Admin images” onto the 
HydroSketch canvas, first click on the “Custom graphics” icon at the bottom of the 
toolbox. A red frame will appear around the tool icon indicating that it’s selected. This 
also opens a pop-up window, a portion of which is shown in figure 6-8.

To bring any image that’s on the list of imported images onto the canvas click on the 
file name. 

Depending on the size of the image file, there may be a momentary delay between 
when you click on the file name and when the image appears on the canvas.
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Once the image is on the canvas click on it.  This creates a temporary editing frame 
around it, along with small square ‘handles’ at the four corners. You can drag any of 
these handles inward or outward with the mouse cursor to change the size of the 
imported image while maintaining its horizontal and vertical proportions. You can also 
drag the image around the canvas as you would with other objects.

Imported images cannot be duplicated, copied, or pasted.  They also cannot be flipped 
vertically or horizontally.  

Imported images can be grouped along with other objects.

Deleting an imported image:

To delete an imported image file click on the trash can icon to the right of the file name.  
You will be prompted with a pop-up asking if you’re sure you want to delete this image.  
Click OK to permanently delete the image.  Click Cancel to return to the drawing without 
deleting the image. Remember that you cannot delete image files listed under 
“Admin image files.”

END of user manual
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